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The instructions in this article cover the various functions available in Certificates. The
icon may be located on your StrataMax Desktop or found using the StrataMax Search.

When a property is sold, the purchaser requires a certificate containing details of the property based on
each state and their legislation requirements. These could include levies, current insurance policies,
exclusive use areas and other documents, as specified for each state.

StrataMax automatically selects the certificate which is appropriate for the building type based on the
state in which the building resides and its legislation. For example, a Queensland building using the type
B.F.P., StrataMax will print a Body Corporate Certificate, or a New South Wales type using an S.P., a
Section 184.

To create the certificate, StrataMax merges info from various areas within the system to produce a
Strata certificate. For example, Office Bearers, Contracts Register, Common Property Register,
Insurance, Levy Management, and balances for a specific lot.

An optional cover letter may be printed automatically with a certificate.

The certificate can be included as a report set and have other reports and documents available as a
standard report using Report Distribution. 

Certificates - Frequently Asked Questions
Q) How do I flick between the Report Distribution version and the old version?
A) Using Certificates in Report Distribution will be available in preview mode from version v5.6.136.  This
will allow your administrator to provide access via Security Setup, and then, as a user, you can choose
to use the legacy version or preview using Report Distribution.

Q) Will all Certificates with a CMS be too large to email?
A) No, as it is dependent on the original file size and whether the CMS was a document scanned as an
image, etc.

Q) What can we do now if the file size is too large?
A) It is recommended that the CMS be deleted from Document Inclusion and the certificate be
regenerated. The CMS can then be attached separately from your PC or DocMax when emailing the
certificate.

Q) Will the current document inclusions be retained with the updated Certificates via the Report
Distribution interface?
A) Yes, all documents will be retained. However, if the document is too large, deleting it from the
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document inclusions and re-adding it is recommended. This will use an improved process that should
retain the original size. Furthermore, if the CMS is loaded in Building Information, the new Report
Distribution interface will automatically include it. However, you must still delete the CMS from the
Document Inclusion.

Q) Will details entered into the Info Editor need to be added again in the new interface?
A) No, these will be retained in the new interface.

Q) Will the current cover letter text be retained in the new interface?
A) Yes, the currently configured cover letter text will be retained in the new interface.

Q) In preparation for the new interface, how can we determine if the CMS has been attached in Building
Information for all of our buildings?
A) We have run a report to help with this. You will find the Excel file has been saved to
BCM\Reports\LinkedCMSDocuments.xlsx. It shows the Doc ID, Document Title, and Added Date for
buildings with the CMS Document field filled in.

Q) In Queensland, a generic signature can be used; can a global signature be saved for all certificates?
A) This is not currently available; however, with Certificates now using the Report Distribution interface,
we are planning on introducing this function in a release coming soon. Currently, you would need to save
the signature for each building, similar to what was done previously with the common seal.

Q) Where there is a requirement to include financial statements, however, sometimes the financial
statements for the Current Year or the Old Year are not applicable, how can we ensure that what is
included is what we want?
A) From Report Distribution, you can include the Financial Statements, using the cogwheel to control the
template and Old/ Current Year information. If you have a saved draft of financials that you want to
attach, use the attachment button in Report Distribution to navigate to where this document is.

Q) In Queensland, on the settlement day of a lot, we are often requested for new levy and outstanding
balance figures; how can we produce this information?
A) Another Certificate can be produced for the required lot, or as an alternative, a Ledger
Card and/or Levy Register could be provided. Another alternative is providing access to online
certificates and including the access ID as part of the cover letter included with the initial certificate.

Q) Old levies are appearing in Levy Management and on Certificates; how can these be removed?
A) In Levy Management, select Options and then Set Current Levies and untag any levies as required.
The levies will still be available to report on and display in Levy Management by ticking Show Historical
Levies.

Email Template Manager
The Email Template Manager will be available to set a global or building-specific template, and includes
merge fields for selection. Once the Subject and Body of the email have been set, click Save and close
the window. 
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Report Distribution - Configuration
Using the cogwheel for the certificate template will provide configuration options across multiple areas
that can be set for each building, including the Applicant Fee and paid status.



Applicant

Applicant Fee. This is where the state-specific fee can be entered to output into the cover letter.

Applicant Fee is Paid. This will control the paid status on the cover letter.

Certificate Settings

All of these settings are global and will affect all users running a certificate.

Print Seal. This will control the common seal output for those that require it.

Attach CMS Document. For those states required to include the registered CMS, if attached using the
CMS field in Building Information, this will enable the output of that document.

Seal/Sig Location. / Global Seal/Sig Location. Use this option to move the seal/sig into the appropriate
area for output in that section of the certificate. This can be done per building or globally, with the
options included.

Remove Seal/Sig. / Remove Global Seal/Sig Location. This will remove any saved seal/sig documents
either per building or globally.



Calculate Current Interest. This will calculate the current interest as of the date when the certificate is
produced.

Current Levies Only. Selecting this option will include the current levies only for the financial year for
each building.

Minimum Asset Value. To control the output of the Asset Register items, set a value threshold to output
into the relevant area.

Substitute Account Manager. If there is a substitute Account Manager to be included on the certificate,
enter the details into this field.

Document Inclusion. This is where additional documents can be added to a certificate, and is available
for this building or global options. 

Info Editor. Use this area to control field output. This will vary for each question and answer from state to
state.

Cover Letter

Add Cover Letter. Use this option to use the cover letter available. The text for this cover letter is
included in the Certificate Cover Letter template.

Manager's Cover Letter for Non-Registered.

Custom Text

This is where custom text can be entered with each field available. If the state-specific template allows
for this additional information, it will output where required. As an alternative, if there is custom text, a
document could be added using Document Inclusion to affix a permanent document or + Attachment for
the one off document.

Creating an Electronic Seal/Signature
The Common Seal and the signature (separately if needed) for a building can be scanned and added to
Certificates. When a certificate is produced, the seal and signature are automatically affixed. The seal
and signature are first saved onto a Word document and can then be imported into StrataMax. 

When the seal/signature is added to the Certificates menu, the document with the Common Seal and
signature is automatically saved in DocMax for that building. The title will be 'Certificate Seal', which
can be used in a Search to locate these documents. However, there will not be a category allocated,
but more details can be added to the document properties if required.

Scanning and editing the Common Seal/Signature

1. Scan the building's common seal and the account manager's signature, or just the signature for

those states that require it, making sure they are scanned in an image format. This should be .png
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or .jpg.

2. Open the image in an image editor program like MS Paint, 3D Paint, Adobe Photoshop Express,

Adobe Illustrator, etc.

All the open space around the seal and signature needs to be removed.

The image size needs to be adjusted so that the height is no bigger than 130 pixels.

3. Once the image has been cropped to remove all the white space around the seal and signature, and

the height is no bigger than 130 pixels, save the image and then insert it into a Word document.

In Word, use the Insert tab and insert a Picture. Navigate to where the image has been saved

and insert this.

4. Save the Word document, and make a note of the folder where it was saved - this will be needed in

the following steps.

Adding an Electronic Seal / Signature to the Building

1. In Certificates, click the cogwheel on the Certificate template.

2. Click the Seal/Sig. Location button.

3. Navigate to the saved Word document with the scanned seal and signature, and click the

Open button. 

4. Click the Seal/Sig. Location button. Check the position of where the seal/signature is, and adjust if

needed. If this needs to be moved, click the image and drag it into position. 

TIP: Run a Certificate to check the placement and repeat step 4 if the position needs to change.

 

Remove the Seal/ Signature

The instructions below can be applied to remove the seal and signature.

1. Search or select Certificates.

2. Click the cogwheel on the Certificate template.

3. Click Remove Seal/Sig. button.



4. Click Close.

Print Seal

The Seal/Signature can be set to print or not print by ticking the Print Seal option, which can be set from
the Certificate cogwheel.

Document Inclusion
Document Inclusion allows documents to be added to a list so that when a certificate is produced, these
documents are automatically printed as an addition to the certificate. Documents can be added locally
(for this specific building) or globally (for this certificate for all buildings).

For QLD CMS document attachment requirements, use Building Information - CMS field to attach the
Community Management Statement.

It's important to note that the documents added to Document Inclusion will not be available via Online
Certificates.

Lots with Utility Subgroup

If the subject lot is in a Body Corporate, which is bulk-billed for electricity. Individual meters for each
lot are read periodically and bills are sent by the Body Corporate manager either to the owner or the
tenant. In any event liability for unpaid electricity charges rests with the owner.

If bills are sent to the owner, the attached certificate will include amounts owing up to the last meter
reading. For settlement, allowance must be made for any amount owing pursuant to a final reading.

The new owner will be responsible for any unpaid electricity charges. It is therefore recommended
that a sum be withheld at settlement.

Adding the Document to the Document Inclusion List

1. In Certificates, click the cogwheel on the Certificate template.

2. Click Document Inclusion. The Certificate Section will be set. If this needs to be adjusted, click the

drop-down arrow and select the required certificate type.

3. Click Add Document, This Building Only or Global. 

4. This will open the DocMax Select Document screen.

5. If the document is already in DocMax, navigate to it and click Select Document.

6. If the document is not in DocMax, you can either navigate to it using the Add New Folder Location

option (in the list to the left) and click Select Document.

7. If this is for a Utilities/ Electricity Letter, select the document type using the drop-down list.

8. Repeat if more documents need to be added.

9. Use the navigation buttons to view, remove or move the order of the document.

10. Close by clicking the X at the top of the Document Inclusion window.
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Deleting the Document from the Document Inclusion List

1. In Certificates, click the cogwheel on the Certificate template.

2. Click Document Inclusion. The Certificate Section will be set. If this needs to be adjusted, click the

drop-down arrow and select the required certificate type.

3. Highlight the document to be deleted.

4. Click the red X and then click Yes to confirm deleting the attachment.

Legacy Certificate Information
The following outlines the legacy certificate information.

Certificates Configuration



This section covers the Configuration settings under the File menu.

Current Year Levies Only (User Setting) 
Only the levies that fall within the building's financial year will be displayed if set.

Minimum Asset Value (Global Setting) 
Any asset below the amount set in this field will not be displayed in the Asset Register on the certificate. 

Certs for Current Year Only (Global Setting) 
This sets the default for which template will be used when the Certificates menu is first opened.

Allow No Record of Emailed Certificate (Global Setting)  
If set, when the certificate is sent by email through StrataMax, it will prompt, 'Do you want to record this
certificate as being issued by email?' If No is selected, the certificate will not be recorded in 'Stored
Certificates'. This setting is not recommended.

Report Settings
Screen 
The certificate will display in screen-mode, allowing for it to be printed, emailed, saved as a PDF or
Saved to DocMax.

Printer 
Sends the certificate directly to the printer.

Template 
This certificate template will be automatically set based on the combination of state and type and
regulatory module for the building. 

Printer, Paper Source and Copies 
Select the printer and tray 'Paper Source' to which the certificate will be printed and the number of
copies to be printed.

Letterhead 
The default letterhead will be printed, or an alternative letterhead (if installed) will be available on the
cover letter for production.
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Cover Letter (Ellipsis button) 
Select from one of the available cover letter templates. The wording of the cover letter will be created
using the Edit Cover Letter button. 

Info Editor 
Some certificates have fields where more information can be added. This also will depend on the state
and certificate. Click on Info Editor and select the certificate from the drop-down list. The editable fields
will appear, and this information can be added for this building only or all buildings that use this
certificate type.

Document Inclusion 
Document Inclusion allows additional documents to be added to certificates from DocMax when they are
produced. Select which certificate type to add a document to from the drop-down list, then select to add
a document to the local building using Add Document (This Building Only) or to add a document to all
buildings that use the certificate type using Add Document (Global). This will open DocMax, which is
ready for the document to be added from this application or a network folder.

Applicant Tab
See also Certificate Applicants to add, edit or delete an applicant.

The Applicant tab is for inserting the details of the individual or organisation that has requested the
certificate. It is also where any applicable fees charged can be recorded. When used, this information
will merge into the cover letter.

Application Fee 
The amount charged for the certificate. 

Select Applicants 
Select the applicant for the certificate created from a list of stored applicants. 

Select Owner as Applicant  
Selects the owner as the applicant for the certificate being created. 

Save Changes to Applicant Details  
If an applicant is selected using the Select Applicant button, additional information can be added to the
Name and Address field and in the Reference field. This button allows the additional information to be
saved to that applicant's record. 

Set Sundry Applicants 
This is used to set up the initial Sundry Applicant. Once set (usually during the installation of StrataMax),
it will rarely be used to create a certificate.

Applicant Details
When creating a certificate, the applicant's details must be added. The Name and Address field will
populate the applicant's name and address details, and the Reference field can be used to enter the
applicant's reference.
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There are three options available:

The applicant's details can be entered manually using the Name and Address field, which is not

recommended.

Select Applicant from a list of applicants.

Select Owner as Applicant to select the Owner as the Applicant.

Application Fee
The fee for the certificate can be entered in this field when the certificate is generated and can be set as
the default, which will print on the cover letter if used and act as a tax invoice using the Paid or Not Paid
radio button. No transactions are created using this area, and the additional Disbursement area can be
set to create an automated charge for the administration of issuing a certificate where needed.  

To set the application fee as a default:

1. Search or select Certificates. 

2. Click the Applicant tab.

3. In the 'Application Fee Amount' field, enter the amount, then select the Paid or Not Paid radio

button.

4. Then click Set as default.

Sealing Clause Tab
The sealing clause is used in certificates to authorise the affixing of the common seal for the plan. As the
wording is slightly different for each state act, you can set a default sealing clause, including a blank
clause for states that may not require this to be included, which will be automatically used when
producing certificates for your state.

Creating or Editing a Sealing Clause
1. Search or select Certificates.

2. In the Sealing Clause tab, select the sealing clause most closely resembles the one you wish to use.

3. Edit the text of the selected sealing clause to contain the wording required in the new clause.

4. Click Save As, then click on Global (available in other buildings) or Local (available only in this

building).

5. Enter the name of the sealing clause, then click OK.

6. Highlight the sealing clause, then click Set as Default. Depending on whether Global or Local was

selected, this clause will be the default sealing clause. 

The wording used in the sealing clause can be customised to suit your requirements; if there is no
legislative requirement for any wording, a blank sealing clause can be saved and set as the default.
Merge fields can be used to merge information found in Building Information or Office Bearers. The
following legend shows the data that can be merged within the sealing clause. 
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{BodyCorpManager} The name of the Body Corporate/Strata Manager from Office Bearers.

{Title} The Strata Plan Number or the name of the building.

{Name} Name of the building.

{PlanType} Plan Type in Building Information

{CTSNumber} CTS Number field in Building Information.

{RegMod} Regulatory Module set in Building Information (If None, this will be left blank).

{FullPlanType&Number}Same as {Title} or the Plan Type and Number.

{PlanNumber} Plan Number field in Building Information.

{Date} Date in the format of DD Month YYYY (e.g. 23 April 2019).

Creating a blank Sealing Clause

The Sealing Clause wording can be adjusted to print blank. If multiple certificate types are used, each
should be reviewed and removed if needed.

1. Search or select Certificates.

2. From the Sealing Clause tab.

3. Select the text from the preview area in the right corner, right-click it, and Delete.

4. Click Save As, select Global for all buildings or Local for the local building option, and enter a

description for the blank wording.



Report Settings Tab
The Report Settings tab has settings which allow other reports to print when a certificate is produced. 

Some state acts and building combinations allow the applicant's details to be printed on the certificate.
For those that don’t, a cover letter can be created and added to the certificates. 

Use Text instead of Com. Prop. register (This option must be selected each time a certificate is
produced) 
When printing a certificate, the Common Property Register is automatically printed along with the
certificate. You may type common property information directly onto a text file for a certificate, or set
this information up in the Common Property Register. This is much quicker and easier if all lots have the
same information.

By default, StrataMax will print the Common Property Register report. 

Common Property Annexure Always  
Tick to print the Common Property Register. Please see this article on managing the Common Property
Register for more information.

Print Cover Letter (This option must be selected each time a certificate is produced) 
Tick to print a cover letter after it is setup. Click Edit Cover Letter button if you need to edit the letter
instructions below on how to create a Cover Letter.

Print Cover Letter with each Certificate (This option must be selected each time a certificate is
produced) 
Set to print a cover letter with each certificate. StrataMax will generate a code which can be used for
applicants to purchase subsequent Certificates online. Refer to On-Line Certificates for full details.

Edit before print 
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Opens the 'Report Data Editor' window after clicking the Proceed button, where certain fields can be
edited to appear on the certificate. This may not work for all templates selected. Note also that this
function is progressively being phased out of this screen as new functionality is being introduced.

New Owner Form 
If set, a Roll Details New Owner form will print with the certificate. 
Right click on the New Owner Form words to open the template selection screen to select the New
Owner Form template.  There are only two templates to choose from. 

Calculate Current Interest 
Interest is calculated daily but does not post on the lot account until a payment is made, or the month
end rollover is conducted. This option will add any accrued interest to the payable amount.

Print Contracts Register 'Always' button 
Click on the 'Always' button to always print contracts.

Print Financial Statements 
Select from one of the options to print a Financial Statement for the Current Year, the Old Year or None.

Print Cover Letter always and Print Cover Letter for each Certificate always  
These two tick boxes are default settings. If set, this will keep Print Cover Letter always and Print Cover
Letter for each Certificate always on.

Creating a Cover Letter
The certificate cover letter uses a cover letter template as a base template and then text can be added
to appear within this template. Merge fields may be used to merge the data on to the cover letter. 

Selecting a Cover Letter Template  
A cover letter template only needs to be selected as required. If changes are required for the text, use
the instructions below to edit the text in a Cover Letter. 

1. Search or select Certificates. 

2. First select the cover letter template in the Settings tab. 

3. Click the button next to the 'Cover Letter' to view the templates. 

4. Highlight the template and click Preview to preview the template, or Select as Global to set the

selected template. 

5. Click Close to close out of the selection screen.

Editing the Text in a Cover Letter



1. Search or select Certificates.

2. In the Report Settings tab, click Edit Cover Letter.

3. Select Global if creating a cover letter that will apply to the certificates in all buildings, or This

Building for this building only.

4. Edit the text in Notepad.

5. Save the text file or close and click Save on the exit prompt.

Edit the Text in a Cover Letter - PEXA & Online Payments
The cover letter can be edited to include the StrataPay Reference Number for the associated Lot
Account so that the details can be used to make payments using the individual unique StrataPay
Reference Number and the StrataPay Biller Code or BSB - this transaction will reconcile automatically
through the Bank Rec.

The BSB number and Biller Code are hard coded on the Levy Notice Deposit Slip and can be typed into
the cover letter following the below steps. 

1. Search or select Certificates.

2. Click the Report Setting tab. 

3. Click Edit Cover Letter. 

4. Select Global or Local as required. Global will report across your portfolio. 

5. Enter text for the cover letter including the BSB/Biller Code and StrataPay Reference special text

<StrataPayRef>:

6. Click File > Save.

7. Produce a sample Certificate for a Lot A/c to ensure the cover letter has been set as required. 

The property Bank Account Number should not be supplied for payments as the transaction will
require manual allocation in the Bank Rec.

Setting the Defaults for the Cover Letter
1. To set the cover letter as the default every time.

2. In the Report Settings tab, at the bottom on the screen is the default settings, check or uncheck the

Print Cover Letter Always and Print Cover Letter with each Certificate option. 

If this is ticked the two options above it (next to Edit Cover Letter button) will automatically be



ticked.

If this is unticked, the two options above will not be ticked.

Printing a Certificate
StrataMax will automatically select the certificate which is appropriate for this building/state. There is
additional information in this article for Queensland Disclosure Statements. 

Before printing a certificate, ensure the following:

Office Bearers and Insurance information is up to date.

All receipts for the subject lot have been posted. 

Utility Groups: There is a a function that will allow any Utility setup to be added to the Certificate

from the Document Inclusion list. The note can also be added on the cover letter.

1. Search or select Certificates.

2. Tag the lot in the Lots tab.

3. Select the applicant in the Applicants tab. Using either the Select Applicant to pick a non-owner

contact or Select Owner as Applicant to pre-fill from the lot selected's contact information.

4. If this is not set for default and is required, type in the fee in the 'Application Fee' field. Select

whether the fee has been or has not been paid, which will be output on the cover page if included.

5. In the Report Settings tab, select the additional reports to include, for example, the Contracts

Register. Once selected, click Always to set it as the Default. For infrequent requests that do not

require these reports to be included, untick the reports before producing the Disclosure Statement.

6. Review the 'Print Seal and Signature' box in the Sealing Clause tab to include or exclude any saved

Seal and Signatures.

7. Set any other disclosure statement or general report settings you require using Info Editor or

Document Inclusion.

8. Click Proceed.

A copy of the Certificate will be available in DocMax and on the Roll as an attachment.

Edit By-Laws Text
These are the required steps to edit the By-Law text.
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1. In Certificates, click Options > Custom Text.

2. Click the By Laws Text button.

3. Notepad will open, where you can enter any required text before saving and closing Notepad.

4. Review the 'By-Laws' section in the certificate via a on-screen preview before printing/sending.

Edit Before Printing
Certificate details can be edited prior to previewing and printing the certificate or disclosure statement.
The information changed here will not be updated in any part of StrataMax. This process should only be
used for minor changes when there is a need for the certificate to be printed before any changes to the
building are made. See the individual articles for each state under the Certificates category for
information on the fields within the 'Report Data Editor' window.

1. Proceed to print a certificate as per the instructions above, then in the Report Settings tab tick Edit

before Print.

2. Click Proceed.
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3. This will present the 'Report Data Editor' window with a list of fields that can be edited. 

4. To edit a field, select the field then click the Edit button.

5. Make changes to the text in this field, then click on OK.

6. When finished changing the information, click Close to continue producing the certificate.

Certificates (Sub-Group)
For Certificates in buildings that have a utility group, a message can be included such as 'Electricity
Supply Charges are Billed Separately', and you should check whether any unpaid amounts apply to this
property. The note could be on the cover letter which can be accessed via Certificates.

Alternatively, in Certificates in Main > Options > Custom Text > Field 2360, type in the message relating
to Utility billing e.g Please Note, this building has sub- metered Utility Billing, please contact this office.
This note will appear under the 'Additional Information' section on the certificate.

If the Sub-Group account is linked to the Main account via data links, and in Certificates > Special, the
option utility notice always is ticked, then the amount of the due but unpaid utility charges for that lot will
be reported under the 'Other Amount Due' field, on the Certificate.

Based on the Sub-Group financials, if using Trading Fund Setup with additional funds the certificate may
need to be edited before printing to update any standard fund balances. For example, Last Year Sinking
Fund Balance will report the balance of the Sinking Fund for the QLD Disclosure Statement.  

The Secretary information may also need to be annually populated via Edit Secretary Address within the
Special file menu. This is due to Office Bearers not existing at the Sub-Group level. When selected, enter
the Secretary Name and address information.

http://smhelp.stratamax.com/help/certificates-main
https://smhelp.stratamax.com/help/trading-fund-setup
https://smhelp.stratamax.com/help/certificates-main#edit-before-printing



